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Introduction

Highlight(yellow) - Location 88
First, Break All the Rules1

1. Management 101

Highlight(yellow) - Page 1 · Location 139
The secret of managing is keeping the people who hate you away from the ones who haven’t made up their minds.

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 157
care about you as a person,

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 157
actively work to help you grow in your career.

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 158
teach you important skills and give you valuable feedback.

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 158
help you navigate difficult situations,

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 159
help you figure out what you need to learn.

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 159
want you to take their job someday.

Highlight(yellow) - What to Expect from a Manager > Page 2 · Location 159
help you understand what is important to focus on, and enable you to have that focus.

Highlight(yellow) - One-on-One Meetings > Page 2 · Location 163
One-on-one meetings

Highlight(yellow) - One-on-One Meetings > Page 2 · Location 166
they create human connection between you and your manager.

Highlight(yellow) - One-on-One Meetings > Page 2 · Location 168
letting your manager into your life a little bit is important,

Highlight(yellow) - One-on-One Meetings > Page 2 · Location 170
Great managers notice when your normal energy level changes, and will hopefully care enough to ask you about it.

Highlight(yellow) - One-on-One Meetings > Page 2 · Location 174
The bedrock of strong teams is human connection, which leads to trust.

Highlight(yellow) - One-on-One Meetings > Page 3 · Location 175
real trust, requires the ability and willingness to be vulnerable in front of each other.

Highlight(yellow) - One-on-One Meetings > Page 3 · Location 180
it is not your manager’s job to completely control the 1-1 agenda.

Highlight(yellow) - One-on-One Meetings > Page 3 · Location 184
good 1-1s are not status meetings.

Highlight(yellow) - One-on-One Meetings > Page 3 · Location 188
Come with an agenda of things you would like to discuss.

Highlight(yellow) - Feedback and Workplace Guidance > Page 3 · Location 193
The second thing to expect from your manager is feedback.

Highlight(yellow) - Feedback and Workplace Guidance > Page 4 · Location 198
A great manager will notice some of the little things you’re doing well in your day-to-day, and recognize you for them.

Highlight(yellow) - Feedback and Workplace Guidance > Page 4 · Location 200
feedback you get from your manager will be somewhat public if it’s praise, and private if it’s criticism.

Highlight(yellow) - Feedback and Workplace Guidance > Page 4 · Location 202
delivering feedback quickly is more valuable than waiting for a convenient time to say something.

Highlight(yellow) - Feedback and Workplace Guidance > Page 4 · Location 202
Praising in public is considered to be a best practice

Highlight(yellow) - Feedback and Workplace Guidance > Page 5 · Location 217
Your manager should be the person who shows you the larger picture of how your work fits into the team’s goals,

Highlight(yellow) - Training and Career Growth > Page 5 · Location 226
responsibility for helping you find training and other resources for career growth.

Highlight(yellow) - Training and Career Growth > Page 5 · Location 232
you are responsible, for the most part, for figuring out what types of training you want.

Highlight(yellow) - Training and Career Growth > Page 6 · Location 252
get mentorship

Highlight(yellow) - Training and Career Growth > Page 6 · Location 260
current peers will turn into their future jobs.

Highlight(yellow) - Give Your Manager a Break > Page 9 · Location 307
If you find yourself starting to actively resent your manager for whatever reason, you probably need to move to a different team or look for a new job.

2. Mentoring

Highlight(yellow) - Listen carefully > Page 13 · Location 383
Listening is the first and most basic skill of managing people.

Highlight(yellow) - Listen carefully > Page 13 · Location 383
empathy, which is one of the core skills of a quality manager.

Highlight(yellow) - Clearly communicate > Page 14 · Location 401
If you expect him to do research on his own before asking you a question, tell him so!

Highlight(yellow) - Calibrate your response > Page 16 · Location 436
interns who feel like the company appreciated their work are the ones most likely to come back after they graduate.

Highlight(yellow) - Mentoring a New Hire > Page 17 · Location 457
Effective teams have good onboarding documents they provide to new hires.

Highlight(yellow) - Technical or Career Mentoring > Page 19 · Location 486
be specific about your expectations and goals

Highlight(yellow) - When you are a mentor > Page 19 · Location 490
It’s also OK to say no to mentoring.

Highlight(yellow) - Good Manager, Bad Manager: The Alpha Geek > Page 20 · Location 511
The alpha geek tries to create a culture of excellence, but ends up creating a culture of fear.

Highlight(yellow) - Good Manager, Bad Manager: The Alpha Geek > Page 21 · Location 537
Alpha geeks make absolutely terrible managers, unless they can learn to let go of their identity as the smartest person in the room and most technical person on the team.

Highlight(yellow) - Good Manager, Bad Manager: The Alpha Geek > Page 21 · Location 539
Highly technical hands-on managers can be good for small teams

Highlight(yellow) - Tips for the Manager of a Mentor > Page 22 · Location 550
As a manager you help your team succeed by creating clear, focused, measurable goals.

Highlight(yellow) - Tips for the Manager of a Mentor > Page 24 · Location 592
Don’t hire interns who are not going to graduate in the year after their internship.

3. Tech Lead

Highlight(yellow) - Page 30 · Location 692
Being a tech lead is an exercise in influencing without authority.

Highlight(yellow) - All Great Tech Leads Know This One Weird Trick > Page 31 · Location 713
You’re going to learn the art of balance.

Highlight(yellow) - All Great Tech Leads Know This One Weird Trick > Page 31 · Location 717
when you have to spend less time on your current talents in favor of learning new things, it’ll feel quite uncomfortable.

Highlight(yellow) - Software developer and team leader > Page 33 · Location 759
As a large project nears its delivery date, there will be compromises on functionality.

Highlight(yellow) - Managing Projects > Page 37 · Location 836
explain the basic ideas of the problem space and the motivations behind my ideas.

Highlight(yellow) - Managing Projects > Page 38 · Location 846
Taking the time to explain is very important.

Highlight(yellow) - Managing a Project > Page 39 · Location 871
Run a premortem,

Highlight(yellow) - Managing a Project > Page 39 · Location 873
Make a launch plan; make a rollback plan. And at the end of it, don’t forget to celebrate!

Highlight(yellow) - Real Life of a Manager > Page 44 · Location 980
remember that you can switch tracks if you want.

Highlight(yellow) - Good Manager, Bad Manager: The Process Czar > Page 46 · Location 1008
It’s a waste of your time to play rules cop,

Highlight(yellow) - Good Manager, Bad Manager: The Process Czar > Page 46 · Location 1011
it’s safe to fail and to be imperfect,

4. Managing People

Highlight(yellow) - Page 49 · Location 1062
“new manager” is an entry-level job with no seniority on any front,

Highlight(yellow) - Page 49 · Location 1071
your team is only as healthy as its individuals,

Highlight(yellow) - Build Trust and Rapport > Page 50 · Location 1081
Build Trust and Rapport

Note - Build Trust and Rapport > Page 50 · Location 1081
Qestions t asl new reportz

Highlight(yellow) - Build Trust and Rapport > Page 51 · Location 1098
see Lara Hogan’s excellent blog post on the topic.

Highlight(yellow) - Create a 30/60/90-Day Plan > Page 51 · Location 1099
Create a 30/ 60/ 90-Day Plan

Highlight(yellow) - Encourage Participation by Updating the New Hire Documentation > Page 51 · Location 1117
create a set of onboarding documents that are edited by every new hire as he gets up to speed.

Highlight(yellow) - Communicate Your Style and Expectations > Page 52 · Location 1122
Communicate Your Style and Expectations

Highlight(yellow) - Get Feedback from Your New Hire > Page 52 · Location 1129
Get Feedback from Your New Hire

Highlight(yellow) - Have Regular 1-1s > Page 52 · Location 1139
Have Regular 1-1s

Highlight(yellow) - Scheduling 1-1s > Page 53 · Location 1147
I encourage you to start with weekly 1-1s and adjust the frequency only if both of you agree that this is more than you need.

Highlight(yellow) - Scheduling 1-1s > Page 53 · Location 1150
Mondays and Fridays are bad days for 1-1s

Highlight(yellow) - The Feedback Meeting > Page 55 · Location 1209
don’t save up your praise—give it freely in the moment.

Highlight(yellow) - Getting to Know You > Page 56 · Location 1221
leave room to get to know the person reporting to you as a human being.

Highlight(yellow) - Mix It Up > Page 56 · Location 1231
try to keep notes in a shared document, with you the manager playing note taker.

Highlight(yellow) - Good Manager, Bad Manager: Micromanager, Delegator > Page 58 · Location 1270
it can be tempting to treat your reports as if they should be mini-mes.

Highlight(yellow) - Gather Information from the Systems Before Going to the People > Page 59 · Location 1296
The worst micromanagers are those who constantly ask for information they could easily get themselves.

Highlight(yellow) - Adjust Your Focus Depending on the Stage of Projects > Page 60 · Location 1306
During the normal workflow, though, it’s usually enough to know what’s moving forward and what is taking longer than expected,

Highlight(yellow) - Establish Standards for Code and Systems > Page 60 · Location 1308
Establish Standards for Code and Systems

Highlight(yellow) - Treat the Open Sharing of Information, Good or Bad, in a Neutral to Positive Way > Page 61 · Location 1327
getting stuck on a problem or making a mistake is often just an opportunity for learning.

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 61 · Location 1347
Some companies have started to adopt software that makes it easy for teams to provide continuous feedback and track that feedback over time,

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 62 · Location 1352
Know your people.

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 62 · Location 1358
Observe your people.

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 62 · Location 1365
task yourself with regularly identifying people who deserve praise.

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 62 · Location 1368
look for something to recognize weekly for everyone who reports to you.

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 63 · Location 1378
When things are going well, praise them, but also make suggestions as to what could be even better in the future.

Highlight(yellow) - Creating a Culture of Continuous Feedback > Page 63 · Location 1379
continuous feedback means going beyond a simple “good job” to really engage with the details

Highlight(yellow) - When it comes to areas for improvement, keep it focused > Page 66 · Location 1445
don’t just blindly report all grudges.

Highlight(yellow) - Avoid big surprises > Page 66 · Location 1451
Avoid big surprises

Highlight(yellow) - Schedule enough time to discuss the review > Page 67 · Location 1457
give people a printed copy of the review as they’re leaving on the evening before the review is scheduled.

Highlight(yellow) - Cultivating Careers > Page 69 · Location 1498
If you’re a manager, you are going to play a key role in getting people on your team promoted.

Highlight(yellow) - Cultivating Careers > Page 70 · Location 1526
If there is no growth potential on your team because there’s no room for people to work at a more senior level, it may be a sign that you need to rethink the way work is done in order to let individuals take on bigger responsibilities.

Highlight(yellow) - Challenging Situations: Firing Underperformers > Page 71 · Location 1554
Feedback, positive or negative, should be a conversation.

5. Managing a Team

Highlight(yellow) - Page 75 · Location 1606
hold responsibility for identifying bottlenecks in the process and roadblocks to success for their team and clearing these roadblocks.

Highlight(yellow) - Page 76 · Location 1614
clearly communicate the timeline, scope, and risks to their pillar partners, and lead the delivery of major initiatives on clear timelines.

Highlight(yellow) - Page 76 · Location 1615
identify areas of strategic technical debt, do the cost/ benefit analysis for resolving this debt, and communicate suggested timelines for prioritizing this to the management team.

Highlight(yellow) - Page 77 · Location 1630
mine was to help them succeed however I could.

Highlight(yellow) - Page 77 · Location 1632
being a good manager isn’t about having the most technical knowledge.

Highlight(yellow) - Staying Technical > Page 78 · Location 1653
you need to stay enough in the code to see where the bottlenecks and process problems are.

Highlight(yellow) - Not Shipping > Page 79 · Location 1689
Infrequent releases can hide pain points

Highlight(yellow) - Unhappiness Due to Overwork > Page 81 · Location 1725
Crunch periods will happen, but there is no reason they should happen frequently.

Highlight(yellow) - Collaboration Problems > Page 81 · Location 1729
showing a willingness to improve collaboration goes a long way.

Highlight(yellow) - Collaboration Problems > Page 81 · Location 1730
Gather actionable feedback from your team, and have productive conversations about possible improvements.

Highlight(yellow) - Collaboration Problems > Page 82 · Location 1745
Using your managerial power to override technical decisions is usually a bad idea.

Highlight(yellow) - The Shield > Page 83 · Location 1774
Sometimes it’s appropriate to let some of the stress through to the team.

Highlight(yellow) - Create a Data-Driven Team Culture > Page 84 · Location 1799
Create a Data-Driven Team Culture

Highlight(yellow) - Create a Data-Driven Team Culture > Page 84 · Location 1804
how much time is spent dealing with outages, or the number of bugs found in QA or after releases).

Highlight(yellow) - Look into the Future > Page 85 · Location 1816
Getting a sense of where the product roadmap is going helps you guide the technical roadmap.

Highlight(yellow) - Review the Outcome of Your Decisions and Projects > Page 85 · Location 1821
Review the Outcome of Your Decisions and Projects

Highlight(yellow) - Run Retrospectives for the Processes and Day-to-Day > Page 86 · Location 1832
regular process retrospective has a lot of value for detecting patterns and forcing a reckoning with the outcome of decisions.

Highlight(yellow) - Good Manager, Bad Manager: Conflict Avoider, Conflict Tamer > Page 87 · Location 1860
Creating a safe environment for disagreement to work itself out is far better than pretending that all disagreement does not exist.

Highlight(yellow) - The Dos and Don’ts of Managing Conflict > Page 87 · Location 1863
Don’t rely exclusively on consensus or voting.

Highlight(yellow) - The Dos and Don’ts of Managing Conflict > Page 87 · Location 1867
Do set up clear processes to depersonalize decisions.

Highlight(yellow) - The Dos and Don’ts of Managing Conflict > Page 87 · Location 1873
if you’re giving negative feedback in the course of a performance review, it shouldn’t be a major surprise to your employee.

Highlight(yellow) - Challenging Situations: Team Cohesion Destroyers > Page 89 · Location 1915
a test of a happy engineering team: “If you buy them pizza in the evening, will they stick around and socialize together, or will they race out the door as quickly as possible?”

Highlight(yellow) - Challenging Situations: Team Cohesion Destroyers > Page 90 · Location 1920
a team whose members are willing to take risks and make mistakes in front of one another. This is the underpinning of a successful team.

Highlight(yellow) - The Brilliant Jerk > Page 91 · Location 1953
you seem emotional, it may undermine you.

Highlight(yellow) - You have 10 productive engineering weeks per engineer per quarter > Page 94 · Location 2008
You have 10 productive engineering weeks per engineer per quarter

Highlight(yellow) - Use the doubling rule for quick estimates, but push for planning time to estimate longer tasks > Page 95 · Location 2032
The popular doubling rule of software estimation is, “Whenever asked for an estimate, take your guess and double it.”

Highlight(yellow) - Be selective about what you bring to the team to estimate > Page 95 · Location 2039
it’s distracting and stressful for engineers to have a manager who’s constantly asking them for random project estimates.

Highlight(yellow) - Be selective about what you bring to the team to estimate > Page 95 · Location 2050
First, get someone to walk you through the systems and architecture, as well as the process for testing and releasing the software.

6. Managing Multiple Teams

Highlight(yellow) - Page 101 · Location 2112
If you don’t have solid blocks of time to dedicate to it and you can’t realistically guarantee solid blocks of time at least a few days a week, any code you write is going to be very slow-going.

Highlight(yellow) - Page 102 · Location 2130
keep at least a solid half-day once a week completely free from meetings or other obligations, and try to use this time at least partially on some creative pursuit.

Highlight(yellow) - Page 102 · Location 2141
Management has fewer obvious quick wins,

Highlight(yellow) - Managing Your Time: What’s Important, Anyway? > Page 104 · Location 2174
so many precise time-management tips encourage reading and responding to email at specific times of the day.

Highlight(yellow) - Managing Your Time: What’s Important, Anyway? > Page 105 · Location 2189
your manager trusts you to proactively deal with all those important but not urgent things before they become urgent, and especially before they become urgent for your manager.

Highlight(yellow) - Managing Your Time: What’s Important, Anyway? > Page 105 · Location 2196
During meetings, look around the room at your team and notice their engagement. If half of them are falling asleep, staring off into space, on their phones or laptops ignoring the proceedings, or otherwise disengaged, the meeting
is wasting their time.

Highlight(yellow) - Managing Your Time: What’s Important, Anyway? > Page 106 · Location 2216
sucking at being a manager would be a choice I inflicted on other people. That’s not fair.

Highlight(yellow) - Decisions and Delegation > Page 107 · Location 2227
The first several months of managing multiple teams can feel like a death march,

Highlight(yellow) - Decisions and Delegation > Page 107 · Location 2234
if you don’t feel a little bit overwhelmed, you’re likely missing something.

Highlight(yellow) - Delegate Simple and Frequent Tasks > Page 108 · Location 2253
If the task is simple and frequent, find someone to whom you can hand it off.

Highlight(yellow) - Delegate Complex and Frequent Tasks to Develop Your Team > Page 109 · Location 2281
If you teams can’t operate well without you around, you’ll find it hard to be promoted.

Highlight(yellow) - “Yes, and” > Page 111 · Location 2318
Responding with positivity while still articulating the boundaries of reality will get you into the major leagues of senior leadership.

Highlight(yellow) - “Help Me Say Yes” > Page 112 · Location 2335
“Help me say yes” means you ask questions and dig in on the elements that seem so questionable to you.

Highlight(yellow) - Appeal to Budget > Page 112 · Location 2339
one tactic that you can use is appealing to time and budget.

Highlight(yellow) - Don’t Prevaricate > Page 113 · Location 2351
When you know that you need to say no, it’s better to say it quickly than to delay and drag out the process.

Highlight(yellow) - Technical Elements Beyond Code > Page 114 · Location 2382
management book First, Break All the Rules2

Highlight(yellow) - Technical Elements Beyond Code > Page 115 · Location 2388
frequency of code releases, frequency of code check-ins, and infrequency of incidents—are the key indicators of a team that knows what to do, has the tools to do it, and has the time to do it every day.

Highlight(yellow) - Measuring the Health of Your Development Team > Page 115 · Location 2392
Create the tools that developers need to do their jobs.

Highlight(yellow) - Frequency of Releases > Page 115 · Location 2399
frequency of code change is one of the leading indicators of a healthy engineering team.

Highlight(yellow) - Frequency of Releases > Page 116 · Location 2417
You’re also responsible for keeping your team happy and productive, and often the solution to this is not cheerleading or paying them better or praising them more, but instead enabling them to be more productive, challenging
them to go faster and do better work, and helping them find the time they need to make their work more interesting.

Highlight(yellow) - Frequency of Releases > Page 116 · Location 2419
push for technical process improvements that can lead to increased engineer productivity, even if you’re not implementing them all yourself.

Highlight(yellow) - Frequency of Releases > Page 116 · Location 2425
Push for time away from the product roadmap to support increasing engineering productivity,

Highlight(yellow) - Good Manager, Bad Manager: Us Versus Them, Team Player > Page 119 · Location 2481
Leaders who favor an us-versus-them style tend to be empire builders, seeking out opportunities to grow their teams and their mandates without concern for what is best for the overall organization.

Highlight(yellow) - Good Manager, Bad Manager: Us Versus Them, Team Player > Page 119 · Location 2488
Before you try to change everything to fit your vision, take the time to understand the company’s strengths and culture, and think about how you’re going to create a team that works well with this culture, not against it.

Highlight(yellow) - Good Manager, Bad Manager: Us Versus Them, Team Player > Page 120 · Location 2498
the company’s values

Highlight(yellow) - Good Manager, Bad Manager: Us Versus Them, Team Player > Page 120 · Location 2509
Leaders who are strong team players understand that the people who report to them are not their first team.

Highlight(yellow) - Good Manager, Bad Manager: Us Versus Them, Team Player > Page 120 · Location 2510
consider the needs of the company as a whole before focusing on the needs of their team.

Highlight(yellow) - The Virtues of Laziness and Impatience > Page 121 · Location 2535
What is the value in automation if you don’t use it to make your job easier?

Highlight(yellow) - The Virtues of Laziness and Impatience > Page 121 · Location 2537
any time you see something being done that feels inefficient, question it: Why does this feel inefficient to me? What is the value in the thing we are doing? Can we deliver that value faster? Can we strip down this project into
something simpler and get it done more quickly?

Highlight(yellow) - The Virtues of Laziness and Impatience > Page 122 · Location 2542
“Faster” is about “the same value to the company in less total time.”

Highlight(yellow) - The Virtues of Laziness and Impatience > Page 122 · Location 2545
Forcing yourself to disengage is essential for your mental health,

Highlight(yellow) - The Virtues of Laziness and Impatience > Page 122 · Location 2548
When you work later than everyone else, when you send those emails at all hours, even if you don’t expect your team to respond to those emails or work those hours, they see you doing it and think it’s important.

Highlight(yellow) - The Virtues of Laziness and Impatience > Page 122 · Location 2552
Queue up the weekend and overnight emails for the next workday.

7. Managing Managers

Highlight(yellow) - Page 127 · Location 2616
One thing that managers have to keep in mind is that part of their job is to ferret out problems proactively.

Highlight(yellow) - Page 127 · Location 2619
The open-door policy is nice in theory,

Highlight(yellow) - Skip-Level Meetings > Page 128 · Location 2635
Skip-level meetings are one of the critical keys to successful management at levels of remove.

Highlight(yellow) - Skip-Level Meetings > Page 129 · Location 2650
What’s keeping you from doing your best work right now?

Highlight(yellow) - Skip-Level Meetings > Page 129 · Location 2651
How happy (or not) are you working at the company?

Highlight(yellow) - Skip-Level Meetings > Page 129 · Location 2657
skip-level lunches with whole teams,

Highlight(yellow) - Skip-Level Meetings > Page 130 · Location 2665
Is this team working poorly with any other teams, from your perspective?

Highlight(yellow) - Manager Accountability > Page 132 · Location 2711
the manager is accountable for the health and productivity of the team.

Highlight(yellow) - Managing New Managers > Page 136 · Location 2796
first-time managers need a lot of coaching.

Highlight(yellow) - Managing Experienced Managers > Page 139 · Location 2851
young companies want to seed their management teams with people who’ve been there from the early days and understand the company’s DNA.

Highlight(yellow) - Managing Experienced Managers > Page 139 · Location 2864
Don’t compromise on culture fit, especially when hiring managers.

Highlight(yellow) - Hiring Managers > Page 143 · Location 2940
High Output Management,

Highlight(yellow) - Hiring Managers > Page 144 · Location 2950
If you’re not doing reference checks when you hire management, you’re doing your team a massive disservice.

Highlight(yellow) - Check the Data > Page 146 · Location 3005
are being written vague, too big, too small? Does the team seem upbeat in their communication style, sharing fun things as well as important work in chat,

Highlight(yellow) - Observe the Team > Page 147 · Location 3014
Boring meetings are a sign.

Highlight(yellow) - Observe the Team > Page 147 · Location 3017
Good meetings have a heavy discussion element,

Highlight(yellow) - Be Curious > Page 148 · Location 3048
The pursuit of why when it comes to organizational problems is the thing that gives you patterns to match on, and lessons to lead with.

Highlight(yellow) - Strategies for Handling Roadmap Uncertainty > Page 153 · Location 3144
Make sure that your teams get adequate time to finish up current work.

8. The Big Leagues

Highlight(yellow) - Page 160 · Location 3261
Reminding people of their commitments by asking questions instead of giving orders.

Highlight(yellow) - Changing Priorities > Page 171 · Location 3465
most people need to hear something at least three times before it really sinks in.

Highlight(yellow) - Changing Priorities > Page 171 · Location 3467
Try to anticipate the questions you might get and prepare answers for those questions.

Highlight(yellow) - Challenging Situations: Delivering Bad News > Page 175 · Location 3545
The worst way to communicate bad news is via impersonal mediums like email and chat, especially mediums with commenting abilities.

Highlight(yellow) - Challenging Situations: Delivering Bad News > Page 175 · Location 3547
the second-worst way to deliver this message, especially to a large group that you know won’t be happy, is with them all in a room at once.

Highlight(yellow) - Challenging Situations: Delivering Bad News > Page 175 · Location 3556
Don’t force yourself to deliver a message you can’t stand behind.

Highlight(yellow) - Challenging Situations: Delivering Bad News > Page 177 · Location 3584
If you’re having trouble getting your 1-1 time honored, send the agenda in advance to remind your boss that you need her attention

Highlight(yellow) - Challenging Situations: Delivering Bad News > Page 177 · Location 3590
nothing shows respect like asking for someone’s advice.

Highlight(yellow) - Challenging Situations: Delivering Bad News > Page 177 · Location 3594
Always ask if there is more you can be doing to help.

Highlight(yellow) - Senior Peers in Other Functions > Page 179 · Location 3626
absence of trust is a fundamental dysfunction.

Highlight(yellow) - Correcting a Culture of Fear > Page 183 · Location 3715
If you want a team that feels comfortable taking risks and making mistakes, one of the core requirements is a sense of belonging and safety.

Highlight(yellow) - Recommended Reading > Page 187 · Location 3794
Daring Greatly: How the Courage to Be Vulnerable Transforms the Way We Live, Love, Parent, and Lead

9. Bootstrapping Culture

Highlight(yellow) - Page 191 · Location 3834
As the team grows and evolves, it’s important to attend to your culture as you would attend to any other important piece of infrastructure that you rely on.

Highlight(yellow) - Page 191 · Location 3841
Instead of talking about process, I talk about transparency.

Highlight(yellow) - Page 193 · Location 3870
Pretending to lack structure tends to create hidden power structures resulting from the nature of human communication and the challenges of trying to scale that communication.

Highlight(yellow) - Assessing Your Role > Page 197 · Location 3948
Using failure to guide evolution lets you apply structure at the right level.

Highlight(yellow) - Writing a Career Ladder > Page 206 · Location 4135
What is the lowest level at which people can sit forever, never getting promoted but also not underperforming? This is your breakpoint level.

Highlight(yellow) - The Outage Postmortem > Page 214 · Location 4290
postmortem, many have started calling it a “learning review”

10. Conclusion

Highlight(yellow) - Page 217 · Location 4340
you have to be able to manage yourself if you want to be good at managing others.

Highlight(yellow) - Page 218 · Location 4357
Look for the other side of the story. Think about the other perspectives at play.


